First Steps Toward Meeting EIT Accessibility
Important: This is a full transcript of the “First Steps Toward Meeting EIT Accessibility” presentation. However, the video starts with an abbreviated introduction followed by the “Covering the Rules” section.  Please view the video for visual examples of the steps presented.  As the presentation proceeds, you will be asked to access this document using the “Try this now!” prompt.  Feel free to use this document to try out the presented technique. Last updated on 08/14/2020.
Special Note: It is the presenter’s intent that this document serves as a good example of an “Accessible” document.
Introduction
Hello, my name is Alex Gomez and I work at the Center for Creative Instruction (CCI).  Today we are covering the First Steps toward meeting EIT Accessibility.  At the CCI, we realize that reaching full accessibility compliance, by campus offices and by each individual, will take many purposeful steps.  The primary focus for the session will be on some of the basics needed to create accessible content in Word and PowerPoint (and we’ll touch just a bit on PDF).  This sample document contains the information I plan to cover today.  As we proceed through the session, I invite you to use the document to try the techniques I present.  We have a lot to cover, so let’s begin. 
My Expertise
Over the last few weeks, I have completed General Overview, Word, PowerPoint, and Basic PDF accessibility training through Deque University.  I took extensive notes while taking these courses, often paused to tryout techniques presented, and carried out additional searching after each training to round out my understanding.  After 30+ hours of study and research, I am nowhere close to being an expert on the topic.  That said, I do feel comfortable covering many basic concepts that will help you towards taking first steps toward compliance.  As a reminder, until February 2021, SUNY Potsdam has access to accessibility training courses through Deque University.  For more info, go to the Accessibility Training section of the Training & Development webpage on the HR website.  
Why
Over the last few years, SUNY has initiated an Electronic & Information Technology (EIT) Accessibility campaign.  The goal is to have all SUNY school meet all federal laws and regulations including Americans with Disabilities Act (ADA) and section 504 of the Rehabilitation Act.  Although it is true the SUNY and SUNY Potsdam sincerely care about creating an inclusive environment for students and employees alike (more students and staff with disabilities enter higher education each year), it is clear that the primary concern that drives these improvement goals is the realities of recent litigation.  The that point, the following is from a SUNY EIT Report submitted in May of 2019.
“Over the last several years, colleges and universities have faced complaints, investigations, and litigation regarding the inaccessibility of their online environments for individuals with disabilities. Many SUNY campuses and SUNY System have been directly affected over the past 24 months through complainant-initiated investigations by the federal Department of Education’s Office for Civil Rights (OCR). Although SUNY has successfully resolved (or is in the process of resolving) these complaints, an aggressive effort by advocates and law firms has emerged targeting institutions that fail to meet their minimum obligations for maintaining an accessible digital environment.
While there remains some uncertainty about the precise technical standards required for ADA compliance, it is clear that postsecondary institutions must make their EIT accessible in order to comply with the Section 504 of the Rehabilitation Act of 1973 and the Americans with Disabilities Act of 1990. At a minimum, this means that campuses must ensure that students with disabilities have an opportunity equal to that of their nondisabled peers to participate in their institution’s programs, benefits, and services, including those delivered through electronic and information technology, except where doing so would impose an “undue burden” or necessitate a fundamental alteration.”
Given the realities of laws and lawsuits, it is our responsibility to comply and meet accessibility requirements.
Who is Accessibility For?
It’s easy to assume that poor accessibility only effects a small number of people, but the number is far greater than you might think.  Yes, this includes the blind, deaf and deafblind, but also those with motor or cognitive disabilities, those with color blindness, low vision issues, and seizures.  If you only consider the diminishing eyesight of each person as they age, that alone means millions of people effected by accessibility issues. Weather someone is born with a disability, acquires one through an accident, or through aging, this issue concerns us all.
Covering the “Rules”
For my presentation, I’m associating all of the specific accessibility steps into three major concepts.  If you actively follow these rules when creating content, your end product will be significantly more accessible.
Rule #1: Let Screen Readers Read
Rule #2: Add Meaning to Visuals
Rule #3: Use Tools and Templates
By the end of this session, you will fully understand what these rules symbolize, and you will be able to use them to remind yourself of actions you need to take in order to create more accessible content.  Let’s cover each of these rules in further detail now.
Rule #1: Let Screen Readers Read
For many, Screen Readers are the primary tool used to access content on websites and within documents.  These tools not only read text, but provide users with navigation controls to quickly skim and find information.  For them to work, content MUST contain properly formatted information.  If that “coded” information is missing, the content will be invisible to the screen reader or may require the user to go looking for hidden information (information that is technically there, but that is in a separate hidden location).  As we proceed with this session, most of the time when you’re advised to do something, it’s so you can allow the screen reader to do its job of reading and navigating. Other times, the advice also accommodates Screen Magnifier accessibility tools which allow users with low vision to enlarge content.
Rule #2: Add Meaning to Visuals
In the far future, Screen Readers may be able to accurately describe what is depicted in an image, graph, or table, but until then, we must provide meaning to this visual content.  Alternate text MUST be provided for these visual bits of information, including when we use “emphasized text” to convey meaning.  For example, let’s say you were communicating the following:
All students in bold below have passed and may proceed to phase 2 of their project.  The rest must resubmit phase 1 drafts with improvements by Friday.
· Jill
· Jake
· Jan
· John
· Jane
Screen readers can’t see visual information like bold, colors, and highlight.  Additional information is needed, so for those who passed in the previous list, the information could be in bold and include the text (Passed).
Rule #3: Use Tools and Templates
Word has features that are specifically designed to properly construct a document.  However, users are often unaware of these features and manually create similar effects.  For example, I always use to create headings by using Bold and increasing the font size.  On the page these “fake” headings look fine, but they lack important information needed by Screen Readers.  As a rule, you should ALWAYS use a program’s specific tool or template to ensure that accessibility coding is embedded within your content.  That said, some tools should be avoided altogether because they don’t currently produce information that can be read by screen readers. I’ll point out some of those features as we proceed.
Title
[bookmark: _Hlk47644664]A title lets the reader know what the document is about, and it can be read by a Screen Reader if it is added to the document’s meta-data.  It should be accurate, descriptive, and succinct and can be different than the file name.  Try this now!  Change the Title of the document.
· On a PC: Select File, Info, and find the Title under the Properties section.
· On a Mac: Select File menu, Properties, and then the Summary tab (Remember, the Menu bar can be accessed by moving your course to the top-edge of your monitor).
Headings
Possibly the most important accessibility step is to add real Headings.  Not only are they critical to Screen Reader navigation, they are fantastically useful when creating content.  Before I show you how to add and modify headings, lets open the Navigation pane.  Try this now!
· On a PC: Select View and the Navigation checkbox located in the Show menu-group.  Then, select the Headings tab.
In the sample document, you can see that the entire document is presented in the Navigation pane as a type of outline.  Screen Reader users can use these headings to scan the contents of a document and quickly navigate to them, and so can you.  Try this now!  Select the Contrast heading and you will be immediately taken to that section. If a Heading has a sub-heading, you can expand or collapse it by using the arrow icons.
· On a Mac: Select View menu, Sidebar, and Navigation. Then, select the Document Map tab.
Heading Styles
Headings are a type of style, which can be found on the Home tab in the Styles group.  If you never apply styles to text, the text is always coded as normal text (normal text is the default), but when you apply heading styles, magical things happen.  Not only can you use them for navigation, they can be used to create a Table of Contents.  There’s more you can do with headings, so check out videos on the Tech Tools website.
Documents can use Headings 1 through Headings 6, but most documents will likely only need the first three.  Regardless, always use headings hierarchically and never skip headings (e.g. never jump from heading 2 to heading 4).
Heading 1: Should normally be the Title of the document.
Heading 2: Should be used for main topics of a document (think sections or chapters).
Heading 3: Should be used for document sub-topics.
Headings should always be detailed and unique.  Never use generic Headings like Step One and never use the same heading.  Let’s say you used Summary twice as a heading within a document, you should add text to each heading to make it more descriptive and unique (e.g. Summary – Word Documents; Summary – PowerPoint Slides).
One final thing, you can change heading formatting (like size, font; color) by using Modify.  Try this now!  Change all Heading 2 styles to purple.  From the Home tab, right-click on Heading 2 in the Styles pane and select Modify.  Use the Modify Styles window to change the color to purple.  Notice that Heading 2 is now purple throughout the document.
Spacing and Typography
I am very particular about my document layout (how things are organized on the page, their position, and spacing).  Word has certain build in spacing that I don’t really like.  Much of this spacing is there to help meet accessibility needs and I’m forcing myself to adjust.  That said, not all the defaults in word are necessarily accessible, so let’s talk about line spacing and fonts.
· Basic Fonts: Avoid using fancy fonts as they are harder to read (both san and san-serif fonts are fine).
· 10 point: Avoid using fonts smaller than 10 points.
· 1.5 Line Space: Using 1.5 line spacing is recommended.
· Paragraph Spacing: Instead of adding a blank line, add spacing after a paragraph.
· Align Left: Avoid using Justify and stick with align left.
In order to adjust line spacing, it’s best to change the line spacing for each text style within your document (Normal, Heading 1, Heading 2, and so on).  Try this now!  View Normal style settings.  From the Home tab, right-click on the Normal style and select Modify.  Select Format, Paragraph, and find the Spacing section.  Notice that the Line Spacing field is set to 1.5 and the After field is set to 12 points.  The After setting adds space after a paragraph.  Selecting this option avoids the need to separate paragraphs using and empty line (blank lines are not optimal for accessibility).  In this document, I use 1.5 line spacing for everything, but I don’t add “After” spacing for Headings.  Those are set at zero.
Images (and Shapes)
In documents or presentations, we use images because they can add meaning, relevance, and context to a topic.  We need to provide that meaning to those that can’t see the image, picture, or shape.  This meaning is always added by at least providing alternate text, but for complex images, a longer description or an accompanying document can sometimes be needed. When adding images, ALWAYS use the In Line with Text layout position.  Microsoft Word employs a two layers system for all content (a text-layer and a drawing-layer).  Only content in the text-layer can be seen by Screen Readers.  Placing images In Line with Text keeps them in the text layer.
Alternate Text
Alternate text (Alt text) should be brief, concise, accurate, and meaningful.  By brief we mean, Twitter Tweet short with no more than 150 characters (or so).  Make your words count and never start with “Picture of a…” or “Image of a…”  Try this now! Open and read Alt Text (image below).  To add Alt Text, double-click the image and select Alt Text from the Format tab.  Notice that in addition to an alt text window, there is a “Mark as decorative” check box.  IF the only purpose of the image is to add beauty/interest and it provides no meaningful information, it is considered decorative.  However, add “Decorative” as the alternate text and don’t use the “Mark as decorative” check box.  Currently, this feature is not interpreted correctly by screen readers.
Figure 1 - Church on lake island (Creative Commons image from pixabay.com)
[image: ]
Watermarks and Backgrounds
In general, don't use background images or watermarks to convey information because they lack alt text capabilities.  In addition, they can interfere with the readability of the text for some users.  If you use Draft (or other watermarks), instead indicate a DRAFT statement near the top of the document.  In this document, I used an IMPORTANT statement just below the title warning about the “Try this now!” prompt.
Complex Images
There are times when more information than just the Alt Text is needed for an image, chart, or graph.  A long description needs to be provided to fully cover the important information depicted.  Employ one of the following options:
· Describe the complex image using text below the image.
· Add a text link below the image to a textual description in an appendix.
· Provide an equivalent data table below the image for graphs.
We’ll talk more about tables later in the Tables section.
Emphases and Color
Although text tools that help bring visual emphases to text (like Bold, Italic, or Highlight) can’t be seen by all users, they are helpful to many users and should be used sparingly (overuse brings other challenges).  That said, these visual tools should never be used alone to convey meaning.  Always remember Rule #2: Add Meaning to Visuals.  Similarly, color should not be used as the only way to convey information, prompting a response, or indicating an action. Viewing or printing a document in black and white (grayscale) can be an easy way to check if meaning or information is missing.
Example (accessible): All students in RED below have passed and may proceed to phase 2 of their project.  The rest must resubmit phase 1 drafts with improvements by Friday.
· Jill (Passed)
· Jake (Passed)
· Jan
· John
· Jane (Passed)
In this example, adding “Passed” after the student’s name ensures those with red color blindness don’t miss important information.
Underline and Strikethrough
[bookmark: _Hlk48136096]A few special notes about Underline and Strikethrough.  Avoid using underline for emphases as in today’s web-saturated world, most people will consider underlined text a link.  Often when editing a document, Strikethrough is used to mean delete or consider removing the text.  If you use the Track Changes feature, Word uses red Strikethrough for these types of editorial changes.  Screen readers can’t see this type of visual information and other methods need to be used.  To find more information on this topic, go to the ADA section of How Do I… webpage on the CCI website.
Contrast
To aid those with low vision issues, contrasting colors between text and background MUST be used.  This topic can get a little complicated depending on the color, so to simplify things, I recommend these colors.
Table 1 - Example of Accessible Text and Background Colors.
	Text Color on Background Color
	 Opposite of Column One

	White on Black
	Black on White

	White on Blue
	Blue on White

	Yellow on Black
	Black on Yellow

	Orange on Black
	Black on Orange

	White on Purple
	Purple on White

	White on Green
	Green on White



Make sure that all colors are on the dark side (meaning Blue means Navy or Dark Blue, not Baby Blue).  If you stick with the very dark colors, you should be fine, just avoid mid to light colors, they can quickly turn into an accessibility issue.
Links
Screen readers announce links and then read the link’s text.  Screen reader users use links to quickly navigate to information.  They should be visually distinguishable (Word automatically does this by adding a blue color and underline). When adding links do the following:
· Use descriptive text for links.
· Don’t use “link” in the description.
· Use text that makes sense when read out of context (text should be meaningful and should never contain generic words like "click here," "here," or "read more,").
· Links must accurately convey the links destination (where exactly the link will take you).
· Include a full, non-active hyperlink for printed copies (e.g.  For help with campus apps and software, go to the Tech Tools training resources website (https://www.potsdam.edu/studentlife/wellness/healthservices/campus-health-alerts/coronavirus-updates/faculty-staff/teachingremotely/techtools).
In this example, notice that the link text gives clear information about where the link will take the user and what they will find.  It will take them to training resources for technology tools.  If the document was not intended to be printed, the full URL to the website could be omitted.
Try this now!  Create a link for the https://www.potsdam.edu/ website.  
1. Type descriptive text followed by parentheses ().
2. Paste the link within the parentheses.
3. Highlight the text and right-click on Link option.
4. Paste the link.
5. Right-click on the full hyperlink and select Remove Link (if necessary)

Tables
Simple tables can be made accessible in Word with a few easy steps.  However, complex tables are best reserved for other formats, such as PDF or HTML.  Don’t create tables using Tabs or the Draw Table tool as these methods will NOT create content accessible by screen readers.  Likewise, you should NEVER use nested tables or split/merged cells within a basic table.  If Word is the only option for complicated tables, break up the data into simpler individual tables that don’t require split or merged cells.
Try this now! Create a basic table (in the space below). Go to the Insert tab, Tables, and select the Insert Table option or you can use the Insert Table boxes to make a selection. Select three columns and three rows.


When Insert Table is used (and your curser is within the table), Word opens the Table Design and Layout tabs.  In Design, notice that by default, the Header Row and First Column checkboxes are selected.   This formatting will allow screen readers to announce the column and row headers for data within the table.  Also, this formatting will export correctly when converting a document to PDF.  If a table spans more than one page, select Properties from the table Layout tab.  Then, select the Row tab and deselect the “Allow row to break across pages” checkbox and select the “Repeat as header row at the top of each page” checkbox.
Reading Tables
Table 3 - Scoops of ice cream sold at local stores yesterday.
	Store
	Chocolate
	Vanilla

	Stewart’s
	20
	33

	Scoops
	30
	14



[bookmark: _GoBack]If you can see the table, you can easily tell that 20 scoops of Chocolate ice cream were sold at Stewart’s yesterday.  You can do this because you can go down the Chocolate column and across the Stewart’s row and find 20.  When you properly format a table, a screen reader does this for the user.  It announces the data found in a cell with the column and row header, so it would announce the cell as Row Stewart’s and Column Chocolate is 20.  If the table were not formatted correctly, the only information that would be provided is 20, which could be in reference to anything.
Captions
Although it is fine to use captions for images and pictures if you want, you MUST use captions for tables.  Currently, Word captions will not transfer to PDF (they’ll need to be added again in PDF), but captioned tables are important.  Try this now! Add a table caption (add it to the table you made in the Tables section).
1. Place the cursor in row 1, column 1.
2. Select Insert Caption from the Reference Tab.
3. Set Label to Table.
4. Set Position to Above selected item.
5. Enter an appropriate name starting with (space) hyphen (space).
Charts and Graphs
Like Tables, Charts and Graphs can be challenging to make more accessible.  For those with low vision issues, don’t use a color key, instead use labels that point to the data.
Figure 2 - Sales by Quarter.
[image: ]
The chart also needs a long description in addition to Alt Text.  Here’s an example: The pie chart represents this year’s sales by quarter: Q1 is 58%, Q2 is 23%, Q3 is 10%; Q4 is 9%.
Other considerations for Charts and Graphs:
· Keep charts “In Line with Text” 
· Add alternative text
· Add long description (normally charts need more explanation that alt text)
· Option 1: Write the full text description in the document itself.
· Option 2: Add a data table with the original data points.
· Option 3: Provide a separate document with long descriptions for the charts. Be sure to make it easy to identify which descriptions belong to which charts.
· Option 4: Create a link to a web page with a long description.
Accessibility Checker in Word
Both Microsoft Word and PowerPoint have an Accessibility Checker tool.  Try this now!  Open the Accessibility tool.
· On a PC: Select File, Info, Check for Issues; Check Accessibility.
The Accessibility pane will display errors it finds in the main window.  Select an error to have it display suggestions on how to address the issue in the additional information area below the window.  It will explain reasons for fixing the error and how to do it.  Although this is a handy tool, do NOT rely on it solely.  Making content fully accessible will require additional effort and knowledge from you.  The Accessibility tool works the same way on a Mac.
· On a Mac: Select Tools menu and Check Accessibility.
PowerPoint
The GOOD news, using PowerPoint’s New Slide templates is the easiest way to ensure accessibility compliance.  The BAD news, using the New Slide templates is basically the only way to make PowerPoint content accessible.  As we explore PowerPoint, keep in mind that almost everything we covered in the Word section applies while working with PowerPoint.
Templates
Try this now!  Open a blank PowerPoint.  Select New Slides from the Home tab.  These “templates” (excluding the blank option) have been specially coded and screen readers can easily see content created with them.  To be honest, I have never used them when creating PowerPoints and I know it will take me some time to get use to using them.  You’ll need to play around with them as you create new presentations.  Later this year, I hope to create a tutorial where I can impart tips and tricks I learn using these templates.
[image: ]
The capture above displays the templates found in the New Slide tool in PowerPoint.  Accessible templates including Title Slide, Title and Content, Section Header, Two Content, Comparison, Title Only, Content with Captions, and Picture with Captions.
Accessibility Checker in PowerPoint
Likely, you already have many presentations created.  You’re going to want to use the Accessibility tool in PowerPoint to check your content.  You can access this tool as you would in Word.
REMEMBER: Don’t rely on the checker as the only way to ensure your presentations are accessible.
Reading Order
Unlike Word, it can be difficult for you to know in what order a screen reader will read slide content, especially if you use additional content that’s not part of the slide template.  To check the order, go to the Home tab, select Arrange, and Selection Pane.  Content in the Selection pane is read from the bottom item up.  To adjust the order, either drag the object to the correct position or select the item and use the arrows. 
Embedded Video
If you plan to share your PowerPoint, embedded videos MUST have Alt Text.  The Alt Text should also include a reminder about how to play the video.  For example, the Alt Text could say, “PowerPoint Accessibility Video, press spacebar to stop and start the video".  Right-click on a video and select Format Video to add Alternate Text.
Transitions and Animations
I like to use transitions and animations because they can add visual interest (and polish) to a presentation.  However, there are some downsides to accessibility if you plan to share the PowerPoint.  Let me pause to say, rarely do I consider a slide presentation, the best way to share text content.  PowerPoints are to deliver presentations and are primarily a visual aid.  Notes, summaries, or even a presentation’s speaker notes are likely better delivered through a PDF or Word document.
When you use animations like Fly in for bullets, PowerPoint brings in each bullet one at a time.  As each bullet appears, Screen Readers go to the top of the bulleted list and read each bullet again (bullet 1, bullet 1 and 2, bullet 1, 2, and 3; so on).  This is time consuming for the user and annoying.  When sharing PowerPoints, keeping animations to a minimum and only using basic transitions will increase accessibility.
The Outline View
Like the Navigation pane in Word, the Outline view is a good way to confirm that text is accessible to Screen Readers.  Select the View tab and select Outline View.  Even though all content in the Outline View is accessible, it does NOT include all images, text boxes, and other embedded or floating objects, even if you added alt text or used other features to make them accessible.
Speaker Notes
Often used for prompts or even full scripts, the Speaker Notes panel is primarily used by presenters, however, this pane is accessible to screen readers.  This means you can use it to provide information like long descriptions of complex graphics, charts, or diagrams, especially when those visual components are added in an inaccessible way (e.g. floating objects).  Be sure to inform users that additional Information can be found in the Speaker Notes pane.
PDF
To close, let me say a few words about PDF documents.  Although converting documents to HTML allows for the most accessibility, most users will likely opt to export to PDF as PDF accessibility tools are easier to learn than coding HTML.  That said, if the user must be able to edit the original document, sharing the file in Word is best.  For Windows computers, it is recommended that you install the Acrobat Pro Add-on as using it will provide the best results when converting to the PDF format.  When content is properly formatted for accessibility in Word, almost all of the accessible content will transfer when exporting to PDF.  Regardless, once content is in the PDF format, use the Accessibility Checker to fix listed errors.  I am still in the process of practicing creating accessible PowerPoint and PDF documents, so I will provide further training sessions on PDF and PowerPoint at a future date.  For more resources, please visit these CCI websites:  Tech Tools and How do I adhere to ADA guidelines and Laws.
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